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Looking forward to 2016?
Given we’re not even halfway through the year this may seem like an odd question, but Office 2016 Preview – 
including the keenly awaited Excel 2016 – is now available to all and sundry (are you “all” or are you “sundry”?).  
We summarise the main new features below.

One such new feature is greater charting power, including being able to produce waterfall charts amongst other 
new types.  Given our estimate that less than 15% of users will migrate quickly to the new version of Office, we 
thought it was about time we showed you how to create these awkward blighters, given our frequently they blight 
our readers.

Until next month. Liam Bastick, Managing Director, SumProduct

Back in March, Microsoft introduced an IT Pro and Developer Preview for the Office 2016 release and now they are releasing a version for the broader 
public. From 4 May (US time), the Office 2016 Preview has been expanded, making it available to Office users everywhere in preparation for general 
availability later in the year.

Office 2016 Preview Now Out

Not only will Office 2016 previewers will get an early look at the next release of Office 
on Windows desktop, users may provide interactive feedback which could shape the 
final version. 

For our Excel readers in particular, Microsoft’s intention is that the apps will learn as 
you work, taking advantage of subtle cues and clues to help you stay on task and get 
more out of Office. On such app is Tell Me, a new search tool available in Excel (as well 
as Word and PowerPoint), which serves up the commands you need by simply typing 
what you want to do (it has been emphasised that Clippy is NOT returning!!)
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Other additions intend to make data analysis faster and easier with new capabilities built into Excel to pull, map, analyse and visualise more simply and 
quicker.  New capabilities include: 

	 •	 One-click forecasting: Create forecasts on your data series with one click to display future trends

	 •	 Intuitive data connecting and shaping capabilities. With integrated Power Query, all data may be centralised, shaped and combined to fit 	
		  business needs providing insights quickly

	 •	 Easy data modeling and powerful analysis: Power Pivot continues to be improved, to perform deeper analysis with high speed

	 •	 Publish to Microsoft Power BI Preview: Workbooks may be readily published between users of Power BI

	 •	 New modern charts and graphs: Now including Box & Whisker, Histogram & Pareto, Sunburst, TreeMap and Waterfall to present data in ways so 	
		  often required by business but not previously available in Excel.

Further, Office 2016 will offer new security, compliance, and deployment 
features, giving organisations more control over sensitive data and IT more 
flexibility in deployment and management, including Data Loss Protection 
(DLP). DLP is now available in Excel, PowerPoint and Word, so that IT may 
centrally create, manage and enforce policies for content authoring and 
document sharing. End users will see policy tips or sharing restrictions 
when the apps detect a potential policy violation.

If Office 2016 Preview sounds of interest to you, it may be downloaded 
from https://products.office.com/en-us/office-2016-preview.  It should 
be noted that the Preview is still a work in progress and not all of the 
features expected to ship in the final release will be available for use now 
(e.g. some of the charts mentioned above).  However, new features will be 
added every month via regular updates.

We are often asked about creating waterfall charts.  Although they may be 
coming to an Excel near you with Office 2016, we know it may be a while 
before some of our readers take the plunge and upgrade.  

For those who don’t know or are afraid to ask, a waterfall chart is a 
variation of an Excel column chart that provides a visual representation of 
what has made a key output vary between one period and the next, viz.

Waterfall Charts

In the above example, the two black columns represent the opening and closing balances for a key output in a particular period.  The intermediary blocks 
represent how various drivers have affected this balance within the period.  Note how increases in value are coloured green and decreases are coloured 
red (slightly fainter if the cumulative total is below zero) in this example.

This graphic can be quite powerful in explaining key variances to end users, as needed.

To aid this month’s article, you can download an example Excel file from http://www.sumproduct.com/thought/waterfall-charts.  If you do decide to 
download it, you can see on the Waterfall Chart worksheet, the opening balance and intrinsic movements are recorded (perhaps linked to calculations 
elsewhere), with the closing balance a calculated cell.
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In this illustration, like with most of my example Excel files, white cells may 
be changed without affecting the calculative functionality of the model.

This table is not yet ready to be used to create our waterfall chart: to 

that end, we need to build an interim Chart Calculations Table (which is 
presented in rows 30 to 44 of the example file).  It is recommended that 
the calculation table is built as follows as the order of the columns should 
not need to be changed when constructing the chart:

In our illustration, our Chart Calculations Table will resemble the following:

Column and Heading Example Formula Explanation

 
G: Opening Balance

H: Closing Balance

I: Positive Invisible

 
 
 

J: Positive Decreasing Visible

 
 
 

K: Positive Increasing Visible

 
 
 
 
 

L: Negative Invisible

 
 
 
 

M: Negative Dec. Visible

 

N: Negative Inc. Visible

 
=G11 (only first row)

=G22 (only last row)

=IF(G12>0,MAX(H11,),MAX(H12,))

 
 
 

=IF(G12<0,-MAX(G12,-MAX(H11,)),)

 
 
 

=IF(G12>0,MIN(G12,MAX(H12,)),)

 
 
 
 
 

=IF(G12>0,MIN(H12,),MIN(H11,)) 
 
 
 
 
 
 
 
 
=IF(G12<0,SUM(J34:K34)-ABS(G12),) 

 
=IF(G12>0,SUM(J34:K34)-ABS(G12),)

 
•	 Provides opening balance

• 	Provides closing balance

• 	 If the particular movement is positive, this takes 	
	 the previous movement’s cumulative 	 	
	 balance; if not, it takes the current movement’s 	
	 cumulative balance.  In either case, the balance 	
	 used must be positive

	 This is used as an invisible column to ‘prop up’ 	
	 the movement that will be displayed

• 	 If the movement is negative, display as a positive 	
	 number the value closer to zero of the movement 	
	 and the last movement’s cumulative balance

	 Together with column I, this will ensure a block 	
	 appearing to go downwards will not go below the 	
	 x-axis (i.e. a value of zero)

• 	 Similar to column J, if the movement is positive, 	
	 display as a positive number the smaller of the 	
	 movement and the current movement’s 	 	
	 cumulative balance

	 Together with column I, this will ensure a block 	
	 appearing to go upwards will calculate correctly if 	
	 the previous cumulative balance was negative

• 	Exactly the opposite of column I, if the 	 	
	 particular movement is positive, this takes the 	
	 current movement’s cumulative balance; if not, it 	
	 takes the previous movement’s cumulative 	
	 balance.  In either case, the balance used must be 	
	 positive

	 This is used as an invisible column to ‘prop down’ 	
	 the movement that will be displayed

• 	 If the movement is negative, this calculates the 	
	 amount of the movement that should be  
	 displayed below the x-axis (the positive  
	 amounts were calculated in columns J and K)

• 	 Similar to column M.  The distinction in whether 	
	 the movement is positive or negative is so that 	
	 positives may be coloured one way and negatives 	
	 another.
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Excel 2003 and earlier Excel 2007 and later

 
• 	 Select the Chart Wizard (ALT + I + H)

• 	 In Step 1, select the Column chart type, and the Stacked  
	 Column chart sub-type (second one on first row)

• 	Click ‘Next’

• 	 In Step 2, ensure the range has been correctly selected.  In our  
	 example, ensure the Series is in ‘Columns’ not ‘Rows’

• 	Click ‘Next’

• 	 In Step 3, add a Chart Title and Axes Labels as required.  The legend 	
	 should not be displayed (it will make the chart seem confusing)

• 	Click ‘Next’

• 	 In Step 4, determine the Chart Location as required

• 	Right-click on any column in the chart and then choose ‘Format Data 	
	 Series…’ from the shortcut menu.  Go to the ‘Options’ tab and select a 	
	 ‘Gap width’ of zero

• 	Delete grid lines if necessary.

 
•	 On the ‘Insert’ tab of the Ribbon, select ‘Column’ in the Charts group 	
	 and the ‘Stacked Column’ chart (second one on first row) from the 2-D 	
	 column charts (ALT + N + C + Right Arrow + ENTER)

• 	Right-click on the chart and select ‘Select Data…’ from the shortcut 	
	 menu

• 	By using the ‘Switch Row / Column’ button if necessary, ensure that 	
	 the Legend Entries are the titles from the top row of the data table (row 	
	 32 in our example) and that the Horizontal (Category) Axis Labels are 	
	 the descriptions from the first column (column D in our example)

• 	With the chart selected, go to the Chart Tools ‘Layout’ tab in the Ribbon 	
	 and select ‘Chart Title’ and ‘Axis Titles’ labels from the ‘Labels’ group

• 	Right-click on the Legend and select ‘Delete’ from the shortcut menu

• 	Right-click on any column in the chart and then choose ‘Format Data 	
	 Series…’ from the shortcut menu.  Select the first entry, ‘Series Options’,	
	 in the first column  and select a ‘Gap width’ of ‘No Gap’ by dragging the	
	 pointer to the left

• 	Delete grid lines if necessary.

 
 
The chart is almost there.  Borders and fill patterns need to be changed for each data series.  Whilst the colours for visible increases and 
decreases are a matter of taste, the invisible columns need to have no border and no fill pattern.  To change these properties, simply select 
the required data series by clicking on the chart, and then:

Excel 2003 and earlier Excel 2007 and later

 
• 	Right-click on the column in the chart and then choose ‘Format Data 	
	 Series…’ from the shortcut menu

• 	Go to the ‘Patterns’ tab and select the ‘Border’ and ‘Area’ properties as 	
	 required.

 
• 	Right-click on the column and then choose ‘Format Data Series…’ from 	
	 the shortcut menu

• 	Select the third and fourth entries in the first column, ‘Border Color’ 	
	 and ‘Border Styles’ and revise as necessary.

 
 
Finally, most modellers will not want the interim data table visible.  Rather than hide it, we always recommend grouping rows or columns 
(in this example, select rows 30:44, then ALT + SHIFT + Right Arrow).  However, with Excel’s default settings, this will make the chart image 
‘disappear’ if the data is not visible.  To counter this irritating anomaly, select the chart (otherwise the options below may be greyed out) 
and then:

Excel 2003 and earlier Excel 2007 and later

 
•	 Go to Tools -> Options on the drop down menu (ALT + T + O)

•	 Go to the ‘Chart’ tab

• 	Uncheck the check box titled ‘Plot visible cells only’

• 	Click ‘OK’.

 
• 	Right-click on the chart and select ‘Select Data…’ from the shortcut 	
	 menu

• 	Click on the ‘Hidden and Empty Cells’ button in the bottom left hand 	
	 corner

• 	Check the check box titled ‘Show data in hidden rows and columns’

• 	Click ‘OK’ buttons (twice).

At this juncture, the chart may now be constructed.  By selecting the Chart Calculations Table (cells D32:N44 in our example), the chart may be built 
as follows:



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

How can I hide the data from a chart without hiding the chart itself?

Advice: This is a common question, all attributable to a default setting in Excel, which is easily corrected.  Consider the following chart 
example:

Imagine you wished to hide / group the data in columns 
B and C, which were used to generate the column chart.  
Without modification, if columns B and C are hidden or 
grouped, the chart will render as follows.

Click on the ‘Hidden and Empty Cells’ button in the 
bottom left hand corner and then check the box labelled 
‘Show data in hidden rows and columns’.

Easy!

Hmm…  Perhaps not the most informative of charts 
ever produced.  To retain the chart image, unhide the 
columns and then right click on the chart and select 
‘Select Data…’ from the shortcut menu.  This produces 
the following dialog box:

Once you click ‘OK’, the chart data can now be hidden:

Reader’s Question
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Registered Address: SumProduct Pty Ltd, Level 6, 468 St Kilda Road, Melbourne VIC 3004
Melbourne Address: SumProduct Pty Ltd, Level 9, 440 Collins Street, Melbourne VIC 3000

Link to Others
These newsletters are not intended to be 
closely guarded secrets. Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:

· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management

If you require modelling assistance 
of any kind, please do not hesitate to 
contact us at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to several useful keystrokes you may or may not be aware of.  This month we consider some 
of the actions mentioned in the articles above:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at http://www.sumproduct.
com/thought/keyboard-shortcuts.

Upcoming SumProduct Training Courses

New York 31st Aug - 2nd Sep 2015: Strategic Planning, Forecasting and Budgeting

London 19th - 21st Oct 2015: Strategic Planning, Forecasting and Budgeting

Hong Kong 26th - 29th Oct 2015: Strategic Planning, Forecasting and Budgeting

Dubai 8th - 10th Dec 2015: Strategic Planning, Forecasting and Budgeting

Keystroke What it does

F11 (After selecting data) Create column chart on new chart sheet

CTRL + 9 Hide row

CTRL + SHIFT + 9 Unhide row

CTRL + 0 Hide column

CTRL + SHIFT + 0 Unhide column


